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Saves all current interface and preference settings in a configuration of your own naming.
Opens a tool that allows you to delete old configuration sets.

Thanks for downloading FileWrangler! 
This manual will show you what this software is all about, how to use it, suggestions for use, and so forth. 
There’s a lot to cover, so let’s dig right in…

The Interface

Initial Folder Path and Full File Path: Shows the folder you are 
affecting, and if you click on a specific file, the full path to that file.

The list of files that will be affected by your renaming choices. A folder 
may contain more items than you see in this listing, depending upon 
your choices for filtering in/out items of a certain type or nature.

Original Name: remains constant until you load a new folder or quit

Current Name: the name of your file as the Finder currently shows 

New Name: shows how your naming choices will affect your files

Renaming: Global choices for setting names en masse. Set a prefix, 
suffix, change the extensions, give your files the same base name or do 
a search and replace.

Formatting: Once you’ve chosen how to rename your files, you’ll 
want to tweak it a little. Want the name in all UPPERCASE? Want the 
date prefix to show last Wednesday in words? Want leading zeros?
Buttons: Open the Advanced Options drawer, or perform a Rename

Filtering: After loading a folder, you might want to alter what files 
are shown. Use the Folder Depth slider to dig through layers of nested 
folders. Show only files with no extension, or which were created after 
a certain date. Only show files with names over 31 characters.
Violations: Tools to highlight and correct potential naming problems.

The Menu

Choose the folder that contains the files you want to rename. You can also drag and drop a folder onto the main file listing.

Exports the currently viewed file listing to your desktop as a raw text file, giving you an option for tagging each file listing.

Oh no! I renamed the files in the wrong folder! Never fear. Use this tool to restore all files back to their original names.

Causes FileWrangler to “forget” the currently chosen folder and wipes the file listing. Leaves interface settings intact.

As with any program of this nature, the tools provided can cause damage if care is not taken while using this software. 
Always back up your files before allowing an automation process to modify them. FileWrangler’s default settings were chosen 
to minimize any problems that may befall one who is not paying strict attention during the renaming process. Changes to 
the default settings can and will alter your file names. Please exercise caution when renaming large batches of files.

As tends to be the case with most freeware/shareware software, this program is provided to you “AS - IS.” The author, Christopher Drum, 
can assume no risk or fault with regard to the operation of this software. Every effort has been made to ensure a solid experience with this 
software, but in using this application you understand and agree that sometimes things don’t always go as expected. You also understand 
and agree that Christopher Drum cannot be held personally responsible for terrible things that may befall you during the operation of this 
software. Christopher Drum accepts no liability for damages (virtual, actual, financial, or otherwise) incurred during the operation of this 
software, even if the matter has been discussed with him prior/during/after the event. You agree that backing up your files before using this 
software was recommended in both the above warning and the “How to Use FileWrangler” sections. Please don’t sue me!

WARNING!!

Installation
Installation is simplicity itself. Simply put the application wherever you wish it to reside and double-click it to launch.

Reloads the current folder. Perhaps the contents of the folder have updated? Use this option to refresh your file listing.

Convenience tool for instantly viewing the contents of your currently chosen folder in the Finder.

Resets all interface tools to your preferred default set.

“Clear Interface Settings” and “Clear File Listing” combined into one keyboard shortcut.

Resets all interface tools to your currently active set.

Currently Active Configuration Set: A popup menu that lets you 
load in previously saved configuration sets.



What is FileWrangler?

As much as many of us enjoy using Mac OS X, there are certainly issues that the current user interface does not accom-
modate. One such missing feature is the ability to modify large groups of files at once. Sure, this could be done in Ter-
minal with UNIX commands, but that solution can alienate those who were drawn to the Mac for it’s GUI (graphical user 
interface) and overall ease of use. Automator offers some interesting, if simplistic, tools for doing similar things. At the 
same time, OS X now prefers we adhere to certain UNIX naming conventions, where we previously had no need to do so. 
How can we quickly apply extensions to our legacy files?

For that matter, OS X users sharing files with OS 9 users run into an interesting problem. OS X allows filenames up to 256 
characters long. OS 9 only allows 31 characters. How can I take a folder of files I want to share and get their names to play 
nicely with OS 9, without having to manually rename each individual file by hand?

Picture another scenario. You’ve taken a bunch of vacation photos with your digital camera. The filenames, as supplied 
by the camera, are not human-friendly. If I have a folder of these vacation photos, how can I give them names that make 
sense to me, without having to rename each file individually?

These are the kinds of file manipulation problems that are addressed by FileWrangler.

How to Use FileWrangler

Before you begin, back up the folder that contains the files you want to rename. I cannot stress this enough.

Show FileWrangler the folder that contains the files you want to rename
Go to the “File” menu and choose “Open Folder”. Alternately, you can drag-and-drop a folder into the blue/white 

striped listing. FileWrangler works with one base folder at a time.  You will only see files that are found immediately with-
in the folder (i.e. - nothing inside subfolders). This is adjusted under Advanced Features…, using the Folder Depth slider. 

Decide how to rename the files
Let’s say you want to name all of the files in your folder as JPEGs with sequential numbering and a reference to 

your birthday. In the “Renaming” section, look for the “Name” subsection and uncheck the “Current” checkbox. The names 
under the “New Name” column disappear. Type “birthday” in the text field to the right, then hit TAB or RETURN. 

In the “Suffix” subsection, choose “Numeric” from the popup menu. Each name is appended with a sequential number. 

In the “Extension” subsection, uncheck “Current”. Type “jpg” in the text field to the right and hit TAB or RETURN.

Rename the files
At this point, nothing has happened to your files yet. Find the “Rename # Files” button in the bottom-right corner of 

the application window and click it. The # reflects the number of files you are working with at any given time. A warning 
message will ask you to verify that you really want to do this. Click “OK” to commit your changes. 

Go to the Finder and open your folder (Shift - Command - R will do this for you) . The files might have to refresh their new 
names in your Finder window, but you’ll see they are now named with the choices you made in the previous steps. 

1

1

2

3

2

3

1



Configuration Sets

The most significant change to 
FileWrangler 1.2 is the addition of 
user-definable configuration sets. As 
development and feedback continued 
on FileWrangler, it became clear that 
everyone has different expectations 
and needs in certain default aspects of 
the program. I was once asked to add 
a popup menu of different violation 

character sets, including one specific to “FTP from Mac OS X to XBox.” Clearly FileWrangler was being used for file naming 
situations I had never (and could never have) anticipated. It was then that I decided to make FileWrangler as generic as 
possible, thereby allowing you to make FileWrangler into what you want and need.

Every interface setting, in both the main interface and the new Preferences… window, can be saved as your own custom 
configuration set. FileWrangler ships with one, non-modifiable configuration set titled, “FileWrangler Default Set.” After 
you set up FileWrangler to accommodate your needs for a specific file renaming need, including such things as custom 
character violations and delimiters, those interface choices can be saved as a configuration set using the menu command 
File > Save Current Configuration… (Command - S).

Once saved, your custom configuration set will be instantly added to the Current 
Configuration Set popup menu. By clicking on this menu, you can select from any 
of your previously saved sets, or revert back to the default set, instantly. Simply 
choose the set you wish to use and FileWrangler instantly updates all interface 
configurations to reflect your new choice.

Preference settings can also be saved with a set, excepting the “FileWrangler 
Default Set.” After saving your preferred interface choices as a set, open the 

Preferences… window (Command - ,). Any changes you make 
to the preferences for a given set, as indicated by the current 
choice in the Current Configuration Set popup menu, are 
instantaneously saved to your set.

If you wish to replace a saved set with new configuration 
settings, simply load the set you want to modify, make your 

changes, then resave the set with the same name as the original. Don’t worry, the save dialog box will default to the 
current set name, so you won’t have to worry about naming it exactly right. You will be asked if you’re sure you want to 
overwrite the original set by the same name. Click “OK” and you’re done. 

As you generate more configuration sets for various purposes, you might 
need to weed out some older sets from time to time. The menu option 
File > Edit Saved Configurations… (Shift - Command - E) is your tool for that 
purpose. Choosing this option will load a window with a list of all saved 
configuration sets (minus “FileWrangler Default Set”). Simply select a set 
you wish to delete and press the Delete key. Alternately, you can select 
multiple sets (hold down the Command key as you click on sets, or use the 
Select All keyboard shortcut Command - A) and delete them all at once.

Your sets are saved in ~/Library/Preferences/com.CMD.filewrangler.plist. 
Save this file if you want to transfer your configuration sets to another 
system, or wish to share with someone else. 

Of course, while it’s nice to be able to create our own configuration sets to 
load as we need, some just want to modify FileWrangler’s default behavior. 
Perhaps your only desire in making a set is to simply override FileWrangler’s 
defaults. Wouldn’t it be nice if FileWrangler would auto-load the set of your 
choice with every launch of the program?

Open the Preferences… window and look at the very bottom left corner. 
The “Default Set Upon Launch” popup menu is your chance to tell FileWrangler which configuration set you want it to 
load every time the program launches. It works just like the Current Configuration Set popup menu and automatically 

updates its contents with every set you save. Simply choose the configuration set 
you want and you’re done. Next time you launch the program, the settings for that 
configuration set will automatically load, awaiting a folder to modify.

The Current Configuration Set popup menu, located in the upper right corner of the main interface. 
This is where you can quickly load and apply previously saved configuration sets

The sheet that is displayed when you save a configuration set. Saving a configuration 
set with the above name will immediately alter the contents of the Current Configura-
tion Set popup menu, as shown in the sample below.



The Application Menu

About FileWrangler:
The author’s email and home page address can be found here, should you need to report a bug or problem with 
FileWrangler. Additionally, the version of FileWrangler you are currently using will be found in the About Window.

Preferences:
Accessible with Command-,. Options for customizing 
FileWrangler to your needs and specifications can be found in 
this window. Please note that preference settings cannot be 
modified for FileWrangler’s Default configuration set, only for 
your own custom sets. This is to insure that the FileWrangler 
baseline configuration is always available for those who 
prefer the “classic” FileWrangler settings.

In the main interface window, in the upper right corner, 
is a popup menu of configuration sets available to you. 
Whichever set is chosen is the set whose preferences will 
be modified (with the exception of the FileWrangler Default 
Set). Let’s look at the preference setting choices available to 
you in order from top to bottom.

Date Format - Using the three popup menus, this let’s you 
set the formatting for dates. These options were previously set in the main interface with FileWrangler 1.1 and 1.0. 
These choices typically seem to be a matter of personal preference and have moved into the Preferences… window. 
Choose the order in which you want your date to be formatted, from month, day and year. Choose if you want the 
date to show up as numbers or English language formatting. Choose a delimiter that separates month/day/year. 

For example, setting the order as year/month/day, in English style with a delimiter of ‘/’ would create the following for 
New Year’s Day:  2005/January/1. Set in day/month/year, numeric with a delimiter of ‘+’ would set New Year’s Day as: 
01+01+2005.

Time Format - Just as a date can have custom formatting of your choosing, so can the time. FileWrangler allows you to 
use creation, modification or custom times in your filenames. Do you want that time to show up in 12-hour or 24-
hour formatting? Should the seconds be included? Do you want the AM/PM designator appended? What delimiter 
should be used between the time fields? This is independent of the delimiter used for date formatting or even in the 
formatting choices in the main interface.

For example, setting 12-hour formatting with the delimiter of  ‘ . ’, including seconds and AM/PM designator would set 
New Year’s Eve as: 12.00.00AM. Please not that the colon (:) is not allowed by the Macintosh OS in filenames and is 
therefore disallowed in all renaming options in FileWrangler.

Violations - Left blank, FileWrangler uses its default character violation set to point out potential filename problems. 
This set can be overridden by typing anything at all into the Character Set text field. Even a single character will 
override FileWrangler’s default set, so do take care when working with this option. 

Additionally, the violation highlight color can be altered to any color of your choosing. You will find that some colors 
work better than others, but far be it from me that I restrict your options. If violation highlighting is turned on, you 
will see the color of the highlighting change in real-time as you choose a new color.

Sequential Numbering/Lettering - If you want FileWrangler to add a sequential numbering/alphabetic sequence to your 
filenames, turning this option on will force the numbering to start at the beginning with each new subfolder. This is 
particularly useful if you choose “Enclosing Folder” as a prefix and “Numeric” as a “Suffix” with a blank custom name. 
Each file will be named and numbered according to its enclosing folder, and the increment for the sequence will be 
restricted to just that subfolder.

Exporting - When exporting a file listing, you may wish for certain settings to show up with every export. The specific 
name to export, the verbosity of that filename and even the pre and post tags can be modified as a default prefer-
ence for any given custom configuration set.

Default Set Upon Launch - Please notice that this preference setting is separated from the others by a thin, grey line. 
This is your visual indicator that this preference setting is a little different than the others. Specifically, this is a truly 
global setting. After you have created your own custom configuration sets, you may wish for one of those sets to 
be your literal default. Simply choose the configuration set you desire from this popup menu. With each launch of 
FileWrangler, the configuration settings of that set will load immediately.



The File Menu

Open Folder:
Accessible with Command-O, or drag a folder into the striped file listing. Any of these 
methods will suffice for choosing a folder of files with which to work. Note at the top 
of the window the bold text Initial Folder Path. This displays the full system file path to 
the folder in which you are working. Please note, opening a folder does not reset your 
interface choices. Additionally, only one main folder may be chosen to work within at 
any given time; however, all subfolders within your main folder are accessible. 

Reload Current Folder:
Accessible with Shift-Command-O. This will force FileWrangler to reload the folder 
you chose to work within, leaving your current interface settings intact. Functionally 

identical to telling FileWrangler to Open Folder… and choosing the exact same folder you are already in.

Restore Original Names:
Accessible with Command-R. Until you choose a 
new folder, reload your current folder, or quit 
the program, FileWrangler remembers the origi-
nal names of the files you are working on. These 
names are displayed in the far right column of the main file listing. Even if you rename your files 100 times in a row, you 
can use this tool to reset all worked-upon files back to their original names, extensions, and extension visibility.

Reveal Folder in Finder:
Accessible with Shift-Command-R. Opens your currently chosen folder in the Finder, showing you it’s contents. Especially 
useful to verify the nagging question, “Did FileWrangler just do what I asked it to do?” after you commit to a rename.

Clear Interface Settings to Default:
Accessible with Command-K, resets FileWrangler’s interface settings back to initial, as if you had launched the application 
anew. Whichever configuration set you have set in the Preferences… window as your default dictates how your settings will 
be affected by this menu command. Leaves your folder choice intact.

Clear Interface to Current Set:
Accessible with Command-Option-K, resets FileWrangler’s interface settings back to whatever configuration settings are 
chosen in the configuration popup menu.

Clear File Listing:
Accessible with Shift-Command-K. Forces FileWrangler to forget the folder you had chosen to work with and clears all files 
from the file listing. Leaves your interface choices intact.

Clear Everything:
Accessible with Option-Shift-Command-K. Forces FileWrangler to forget the folder you had chosen to work with, clears all 
files from the file listing, and resets all interface choices back to your default configuration. Essentially “cleans the slate.” 
Functionally identical to choosing Clear Interface Settings to Default and then Clear File Listing.

Save Current Configuration… :
Accessible with Command-S. All current settings in the main interface 
are saved with the name of your choosing. The configuration popup 
menu, located in the upper right corner of the main interface window, 
will immediately reflect your newly saved configuration set.

Edit Saved Configurations:
Accessible with Shift-Command-E. In the listing that displays, select as 
few or as many configuration sets as you desire, then press the delete 
key to remove those configuration sets.

Export File Listing As Text:
Accessible with Command-E. The listing of your file names can be 
exported as plain text to the desktop. Use this function and it’s 
corresponding window to decide which names to export, and how 
much of the file path to include. Additionally, you are given an 
opportunity to append tags before and after each filename. Useful 
for exporting the names as list items for an HTML document, or for 
inserting SQL commands. A preview is provided in the inset box. Click Export to create the file.

Whatever the file may be named in the Finder, as indicated under the Current Name header, 
will be replaced with it’s Original Name and extension, as displayed under it’s header, when you use the Restore Original File Names option.

The exporting options window. In this example, every file listed in the “New Names” column is getting 
it’s full file path tagged as individual HTML list items in the final export. 



Prefix/Suffix:
Will add text of your 
choosing to the begin-
ning and/or end of your 
filename. The popup 
menu has five choices:

Numeric - numbers the files in your folder sequentially. Numbering starts again at 1 for every nested subfolder.
Alpha - letters the files in your folder sequentially. Lettering starts again at “a” for every nested subfolder.
Enclosing Folder - the immediately enclosing folder of each file. Use it in conjunction with the alpha/numeric choices 

to do instant folder-name-plus-a-number file renaming.
Date - add the date of your choice, formatted numerically or in English.
Custom - turns on the neighboring text field so you may type in any text you wish

Name:
The Current checkbox sets the name found under the “Current Name” column as the base for your new filenames. Leaves the 
name as-is. Uncheck it, then type a custom name in the adjacent text field to give the same base name to all of your files.

Extension:
The Current checkbox puts in the extension found under the “Current Extension” column. This leaves the extension as-is. 
Uncheck this box to type in an extension of your choice that is applied to every file in your list.

Search/Replace:
Type some text into the Search Field and the Replace Field becomes active. Type in text with which to replace your search 
choice. Done! Affects the name as currently shown under the “New Name” column. Has nothing to do with file filtering.

Clicking this button in the main window…

…will open this drawer. See the subsections on Filtering and Violations for more information.

Renaming

Hidden, cool feature! Set up the prefix and suffix, then change your mind.  Rather the prefix become the suffix and vice versa?  Click the word “Prefix:” or “Suffix:” to swap the two!

Advanced Features:
Accessible with Command-F, or click the Advanced Features… button 
in the lower left corner of the main window. A drawer will open, 
revealing further choices for working with your files. This includes 
Filtering options and Violations.

The Edit Menu

Shift Extension Left/Right:
Accessible with Command-Left Arrow and Command-Right Arrow. 
Sometimes a filename just doesn’t conform to the nice, neat 
format of “filename.extension”. Sometimes, the “.” has been used 
on filenames to denote other information. Take the filename 

“pic1.vacation.shanghai”, for example. OS X (and therefore FileWrangler) interpret this file as having the name “pic1.
vacation” and the file extension “shanghai”. Unfortunately, this makes it incredibly difficult to assign a new extension to 
the file without eliminating potentially important filename data. In this example, changing the extension to “jpg” would 
eliminate the critical information of where the photo was taken, “shanghai”.

While holding down the command key, select 
every file that FileWrangler has incorrectly 
guessed at the extension. Now, choose 
Extension Shift Left to move period-delimited 
“chunks” of the filename from the New/Current 
Extension column into the New/Current Name 
column. Extension Shift Right will do the opposite, moving “chunks” of period-delimited text in your filename from the 
New/Current Name column into the New/Current Extension column. Every chunk is remembered, even if you cannot see it.

Shifting essentially teaches FileWrangler a new way to think about your filename. Once shifted, all filters, violations and 
naming will act as you would expect. In our “shanghai” example, we are left with an empty extension. FileWrangler now 
correctly understands this, so we can filter to see only files with missing extensions and this pic would be caught.

Our original filename, with the incorrectly identified extension of “shanghai”. The effects of Shift Extension Left on that filename. 
Ready for a proper extension!

The Window Menu



Unlike other, similar 
programs, FileWrangler 
takes a more “task based” 
approach to file renam-
ing. After you have set 
your naming under the 
“Renaming” section, the “Formatting” section gives you a chance to tweak the specifics of how FileWrangler formats your 
choices. Some formatting options that are typically set once and forgotten are found under the Preferences… window.

Trim:
Primarily for those who need to truncate long filenames into something just a bit 
shorter. Choose from the popup menu whether to trim characters from the beginning, 
middle or end of your base filename. Type in the number of characters to trim in the 
adjacent text field. Does not trim any custom prefix or suffix you have applied, nor 
the extension. The word “alphabet” trimmed five characters from beginning, middle 
and end would result in: “bet”, “alt” and “alp”.

Additionally, you may choose 31 - Beginning, 31 - Middle, 31 - End. These choices will trim any names that are over 31 char-
acters to exactly 31 characters, leaving shorter names alone. The three choices allow you to choose whether the trimming 
happens from the start of each filename, the middle, or the end. Leaves extensions intact.

Delimiter:
Places text between the prefix, name and suffix. The author recommends keeping the delimiter very short, like just a 
single character... an underscore, for example. So, a filename like “prefixnamesuffix” will become “prefix_name_suffix”.

Numbering:
If you have chosen “Numeric” in the Prefix and/or Suffix popup menu(s), this lets you decide how that numbering is for-
matted. Choose your leading zero choice from the popup menu, and/or type in a number in the “Start #” text field. Type a 
value into the “Step text field” to have FileWrangler do an incremental jump between each item, i.e. 5, 10, 15… Number-
ing continues sequentially through all files, by default. If you wish for numbering to begin anew with each new subfolder, 
open the Preferences… window and check on “Reset sequence with each subfolder?”

Change Case:
Choose from four options in the popup menu. The entire filename will reflect your choice, including custom pre/suffixes. 

Keep Original: leaves case formatting alone. 
Title Case: Sets Every New Word With A Capital Letter. 
UPPERCASE and lowercase: are SELF explanatory.

Date & Time:
If you have chosen “Date” or “Time” for your prefix and/or suffix, these tools become available, starting with the Date/
Time popup menus. Additional formatting options can be found in the Preferences… window.  

Today or Now: today’s date or the absolute current time. Every refresh of the file listing updates the date and/or time 
to reflect the exact current day and/or time.
Creation: the (possibly unique) creation date/time of each file. 
Modified: the (possibly unique) modification date/time of each file. 
Custom: gives you a chance to type in a date/time of your own choosing in the text field to the immediate right.

The Custom Date text field accepts natural language as well as standard numeric mm/dd/yy or yyyy format for inputting a 
date. Examples of acceptable date: “yesterday”,  “last wednesday”,  “two weeks ago”,  “tomorrow”, “June 4, 1971”,  “5/15/81”. 
The Custom Time text field accepts natural language and standard numeric input. “12:00:00 AM” and “midnight” are equally valid.

Extension Visibility:
When you click the Rename Files button, this menu choice sets whether the extension is displayed in the Finder or not. 

Keep Original: looks at each file in your list and sets the extension visibility to match what the original file used.
Hide: the extension will exist, but will not be visible in the Finder. 
Reveal: will force the extension to be visible in the Finder.

Formatting

Hidden, cool feature! Notice the text field by the Date subheading? It accepts “Natural Language” input.  Don’t know what the date was for “last Thursday?”  Type in “last Thursday” and see.



In the Advanced 
Features… drawer, 
FileWrangler has ad-
ditional tools for those 
who need more exacting 
control over which files they are renaming. Folder recursion, name/extension/date filters, and more are located here. The 
choices made in the Filtering tools will refresh your currently viewed list of files to show more or less items, depending 
upon the specificity of your filtering choices.

Folder Depth:
The author’s personal favorite tool in FileWrangler. Once you’ve chosen a folder in which to work, that folder may have 
subfolders. Those subfolders, in turn, may have their own subfolders, etc, etc, etc… FileWrangler has the ability to recurse 
through your folder structure, to show all files in your chosen folder. However, where it gets really interesting is that 
you get to choose how deeply into the folder structure the application recurses. Notice the left and right most titles on 

the slider: “Base” will only show those files that are in the immediate folder 
you chose. “All” will drill down through EVERY subfolder in your chosen folder, 
showing you EVERY file. The tickmarks between the two represent one additional 
level of recursion. So, if you move the slider to one mark to the right of “Base”, 
you will see all of the files in your base folder, plus anything in the first layer of 
subfolders. Each tickmark adds a layer, up to ten subfolders deep. The author has 
made an assumption that anyone needing to see everything ten subfolders deep 
probably just wants to see everything. The final tick mark does exactly that.

Name Filtering:
This popup menu lets you filter the original files by name. Choose an option, then enter your text in the adjacent field. 

Name contains: will only shows those files that contain the text of your choice. 
Name exactly matches: only shows those files whose name is exactly what you type into the text field. 
Exclude names with: will show all files except those with the text of your choice. 

So, if you have a stack of photos, some of which are named with a reference to your “vacation”, you might want to leave 
those alone. Choose “Exclude names with:”, type in “vacation” and your list of files will sort automatically.

Extension Filtering:
This popup menu lets you filter the original files by name. Choose an option, then enter your text in the adjacent field. 

Missing extension: shows only those files in your chosen folder that have no extension.
Extension matches: shows only those files whose extension matches exactly what you type into the text field. 
Exclude extension: shows all files except those with the extension you type into the text field.

Say you have a stack Microsoft Word documents, with blank icons and no extension. Choose “Missing extension:” to see 
only those files. In the Renaming section, uncheck “Original” under “Extension” and type in “doc” (for example). 

Date Filtering:
The first popup menu lets you choose whether to filter based on the files’ modification or creation date. Once you’ve made 
that choice, the second popup menu becomes available, allowing you to choose whether to filter the files for those that 
are on, before, or after your date choice. After you’ve made this comparison choice, type a date into the text field. Just like 
the Date Formatting tool, you can use natural language to put in your reference date.

Checkboxes:
These options give you the ability to hide or reveal large groups of files, based on common filtering needs.

Only show names over 31 characters: checked on, will show only files whose name, including extension, 
is over 31 characters.

Ignore Files - Invisible: checked on, will ignore any file that is invisible, or which is enclosed in an invisible folder. 
Ignore Files - System: checked on, will ignore any file contained in a System or Library folder, or ends in .plist. 
Ignore Files - Apps: checked on, will ignore any file contained in the Applications folder, or enclosed in an .app file.

Filtering

Each tick mark will dig through one additional layer of folder structure. “Base” 
will only show files found in the initially chosen folder. “All” will show every file 
in every subfolder. The tickmark to the right of “Base” will dig in one layer of 
subfolders, then two, three… up to ten deep, after which you may select “All”.



Violations

The Violations subsec-
tion contains some 
convenience tools for 
wrangling your file-
names quickly to address some specific file naming issues. All violation highlighting will show in the Original, Current and 
New Name fields. This will allow you to see if the current filename has a violation that the new filename has remedied. The 
violation characters and the violation highlight color are completely user-modifiable under the Preferences… window. 

Highlight names over 31 characters:
Check this on to highlight in bold, red text any file whose full file name is over 31 characters. This highlighting is dy-
namic, and file names highlighted thusly will “turn off” as soon as the new name drops to 31 characters or less. Great in 
conjunction with the “Trim” formatting tools. 

Highlight names with character violations:
Filenames that contain certain symbols can cause havoc on some UNIX 
boxes. I have made a set of characters that have been known to myself to 
cause trouble. The default character set FileWrangler checks for is: 
	
	 $   /   .   *   :   ’   \   ”  ;   #   [   -   ]   {   }   ~

Filenames will highlight with a light pink background, by default, if they 
contain any of these symbols. It should also be noted that the character “:” will 
convert to a “/” automatically by the OS X file system (i.e. - the Finder). This set 
of characters represents FileWrangler’s default violation set. Please note that 
in the Preferences… window you have the option of creating your own, unique character violation set. Maybe you really hate 
vowels. Type in “aeiou” in the Violations Character Set text field to highlight all words that contain any or all of those vowels.

Replace blank spaces with:
Filenames with blank spaces, especially those files that will be shared across networks and stored on file servers, would 
benefit from not containing blank spaces in the filename. Type in a symbol with which to replace all blank spaces in your 
filename. If a file is named, “This is my file,” after typing “_” into the text field the filename would be, “This_is_my_file”.

Replace violation characters with:
Uses the same set of “violation” characters as shown above in “Highlight names with character violations”. If your filename 
contains one of those characters, and you want to simply eliminate all potential violations immediately, type in a non-vi-
olation character (or characters) into this field to sort it all out en masse. This field will not allow the input of any violation 
characters. Note that all violations will be replaced with the same character(s) you type into this field.

The effects of turning on violation highlighting…

The first filename contains FileWrangler default character violations. 
The second filename passes both violation tests. 

The third filename is over 31 characters. 
The fourth filename is over 31 characters AND contains a FileWrangler character violation.

Other Things to Know About FileWrangler

FileWrangler is free and not limited in any way, nor will it ever bug you for registration. 

FileWrangler has now had some 15,000 downloads, with multiple 5-star reviews on MacUpdate and VersionTracker 
and even inclusion on the cover disc for the German Mac magazine “MacUp.” Thanks to everyone who helped make 
FileWrangler such a success, and contributed to it’s future success by submitting comments and bug reports!

FileWrangler has been extensively tested on OS X 10.4 and 10.3. It is both Tiger and Panther compatible. It does not work 
on any version of OS X 10.2 or earlier. 

FileWrangler may not work for folders with over 10,000 files in them. I recommend that renaming tasks of that size should 
be broken down into smaller chunks, that you may verify the program is doing what you had hoped.

Comments will be lost when you rename files. This convenience will be provided in a future point release.

The Search/Replace fields are not at all related to the filtering functionality of FileWrangler. If you’re looking for files with 
a specific word in their names, use the Name Filtering options for that purpose.

There is no “Undo” option in FileWrangler, except for the critical purpose of restoring filenames to their original state (File 
Menu -> “Restore Original Names”). This convenience will be provided in a future point release.

Bugs, errata and/or comments may be sent to: christopherdrum@mac.com

mailto:christopherdrum@mac.com 


I Love FileWrangler! I Want To Reward You For All of Your Hard Development Work!

Oh, shucks, you’re just too kind. Look at me… I’m blushing. Anyhow, if you would like to contribute to FileWrangler’s 
future and/or my future as a Macintosh developer, I have a suggested donation fee of $5.00. 
I use PayPal, under the email address: christopherdrum@mac.com

Version History 

Version 1.2 – Released June 24, 2005
	
	 Bugs Fixed:
	 Setting the case of a filename now properly renames files if that is the only option chosen.
	 The trim function was trimming too heavily. It now correctly does not trim custom naming choices.
	 “:” (colon) disallowed in text fields to adhere to OS X naming restrictions.
	 Extensions with a “/” (forward slash) were not being read properly.
	 “Advanced Features” drawer button now behaves like a proper drawer button.

	 New Features:
	 User-definable configuration sets.
	 Preferences. Further refine configuration sets and choose a default set to load upon application launch.
	 Tools for creating and deleting configuration sets.
	 User definable violation character sets and highlight color.
	 “Time” is now an option for prefix/suffix choices.
	 Renaming of RTFD documents now supported.

	 Additional Changes:
	 Tool tips updated to reflect new options.
	 Manual updated to incorporate 1.2 changes.
	 “Clear Interface Settings” menu options updated to work properly with new configuration set tools.
 

Version 1.1 – Released November 26, 2004
	
	 Bugs Fixed:
	 “Clear All Settings” wasn’t properly clearing all interface settings.
	 Prefix/Suffix delimiter didn’t behave as expected, putting in extra delimiters when not necessary.	
	 File names with a ‘/’ were being interpreted as a ‘:’ by the file system. 
	 Sometimes files with a missing extension would not inherit a newly appended extension.
	 If file extension visibility is the only option chosen, FileWrangler would not set the extension visibility properly.
	 Clicking on a file with no extension would display an erroneous period at the end of the full file path
	 Filenames with 32 characters could mistakenly be read as 31 characters and vice versa.
	 Delimiter handling should act more as expected, between prefix, name and suffix. 
	 Original Name column now shows the full, Finder-visible filename.
	 Memory leak patched.

	 New Features:
	 Can now tell FileWrangler to shift an improperly identified extension into the name column, or vice versa.
	 Tool Tips added for all interface elements.
	 Clear File Listing allows you to force FileWrangler to forget about the folder you had chosen.
	 Clear Everything clears all interface choices and forgets the folder you had chosen.
	 Reload Current Folder tells FileWrangler to reload whatever folder you had chosen, perhaps to refresh it’s file list.
	 Can now add a specific delimiter between month/day/year in the Date Formatting tools.
	 Reveal chosen folder in Finder.
	 Export file listing, with tags, to raw text file.
	 Filenames can now be trimmed to exactly 31 characters.
	 Step number added to number formatting, to allow for incremental jumps in a numerical sequence.
	 Invisible extensions now show as italicized in the Current Extension column.
	 Colons are automatically replaced with a forward slash by OS X. FileWrangler now alerts you if this has happened.
	 Violation highlighting now highlights all violations in all columns.
	 Code improvement to the renaming process results in faster renaming, especially for long file lists.

	 Additional Changes:
	 Keyboard command to open the Advanced Features… switched to Shift-Command-F.
	 Manual updated to incorporate 1.1 changes.

Version 1.0 – Initial Release – November 6, 2004
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